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Welcome to version 1.6 of WaveLab!
We continue to prove our point: WaveLab is an ever evolving program. We are
pleased to hereby present an even further expanded version of the premier W
dows 95/NT audio editor program: WaveLab 1.6!

About this Document
This is a supplement to the WaveLab 1.0 and 1.5 manuals and only describes
features in version 1.6.

Please use one of the methods described below to quickly find the desired inf
tion:

• Use the Table of Contents provided by the Adobe Acrobat Reader pro-
gram.

• Use the Adobe Acrobat Reader Search function.
• Click on a cross-reference (green text) to jump to the respective topic.

It is possible to print out this document or parts of it.

Additional Information on how to use the Adobe Acrobat Reader program can
found in its on-line Help.
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New features

CD-burning

This version of WaveLab includes all the software tools you need for creating
fessional red book compatible audio CDs. In addition, it allows you to import au
tracks directly from CDs (this requires a CD-ROM or CD-R unit connected via
SCSI, see page 42).

Most of the preparations for CD burning is done in the new CD Program wind
This window allows you to collect all the files for the CD, and make settings fo
each one. However, this window can be used for other purposes, as a generic
list" or as a "pool" of audio files.

● If you are using WaveLab in any other language than English, please note that 
some error messages, related to CD writing, will still appear in English, be-
cause they are part of the CD-R drivers themselves.
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Supported CD-Recorders

For CD writing, WaveLab uses a software engine developed by the company 
Quadrat (this company has also developed "WinOnCd" and "WinToGo"). This 
ware engine relies on driver files placed inside WaveLab’s System folder. You
be able to find new versions and additional drivers on the CeQuadrat Internet
site (http://www.cequadrat.com) whenever they become available. These files
also be distributed with updates of WaveLab, please check the Steinberg Inte
site (http://www.steinberg.net) regularly.

WaveLab will work with all CD recorders supported by CeQuadrat (we don’t p
vide a list here since it is updated regularly), as long as they support the "Disk
once" mode (required to create fully red book compatible audio CDs). 

Finally, please note that not all devices support all of WaveLab's functionality.
example, some devices do not support track "Sub-Indexes" (which is not requ
for most applications).
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Other New Features

• ActiveMovie plug-in support. See the on-line help for details about this.
• A new plug-in called StereoExpander. This turns a mono recording into stereo. 

It can also be used on stereo material to increase the "stereo width".
• The file dialogs (Open and Save) have a number of new features: 

1. Audio file preview. 
2. A recently accessed folders feature.
3. Various type of file views.

• You can now set things up so that temporary/intermediary audio files always 
have 24 bit resolution, even if you are working with 16 bit audio files.

• Drag and drop copy/move of audio material now takes zero crossings into ac-
count. This means that when using these techniques for editing audio, it is less 
likely that clicks and pops will occur.

• The new software protection will only request you to input the original CD, 
once after installation.

• As a consequence of the CD-R implementation, the handling of audio file 
markers have undergone some major changes. For example, there are several 
new types of markers, marker operations can be undone/redone, and the 
marker positions retain their positions in relation to the audio, even if addi-
tional material is inserted or deleted from the wave file. See page 60.
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New System requirements
To burn CD-R disks you need the following in addition what is already specifie
the 1.0 manual and 1.5 addendums:

• A CD-R recorder .
The device must support the "Disk-at-one" mode.

• A Windows 95 compatible SCSI controller, for connecting the CD-R recorder.
We strongly recommend you buy a fast (PCI) card, of a trusted brand. Adaptec 
has proved to be a reliable choice. The quality of the card and its drivers will 
seriously affect the reliability of your system. See the Troubleshoooting in the 
on-line help for more details.

• A fast hard disk.
The speed of the hard disk also affects the reliability of the CD-R writing. If the 
hard disk is too slow, you might run into a problem called buffer under-run. 
Again, see the Troubleshooting in the on-line help for details.
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Preparations and Installing the CD Recorder

WaveLab settings

• If CD burning will be your main activity in WaveLab, we recommend you 
to open the Preferences dialog, click the File tab and select the "Optimize 
for huge files" mode.

• For all general instructions on installing SCSI cards and CD-R recorders, 
please refer to the instructions that came with the computer, Windows, 
the SCSI controller and the CD-R recorder itself.

For WaveLab, please just check the following points:

• Make sure to have the latest firmware version installed in your CD-R 
unit. The firmware you have must support Disk-At-Once mode! In addi-
tion, running a unit with an older firmware might for example prevent 
you from writing Sub-Indexes into the Tracks.

• It is not required by WaveLab that you have a general Windows driver in-
stalled for the unit, since WaveLab has built in drivers for all the sup-
ported units. If you need to install (or already have installed) another 
driver for the unit, please be aware that there are possibilities for driver 
conflicts. If things seem to work well, don't do anything. If you run into 
problems, check the Troubleshooting section in the on-line help.
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Selecting a CD Recorder

Before you start writing, you must specify which CD-R unit WaveLab should u
(for example, you can have more than one unit connected at a time, and swit
tween them from within WaveLab).

1. Pull down the Options menu and select "Select a CD Recorder".

The “Select CD Recorder” dialog.
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2. Use the pop-up menu to select your recorder.
The boxes below and to the right will show you details about and settings for 
your specific CD-R unit. Please use the context sensitive help to get more info 
about the dialog.

3. Click OK to close the dialog.
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Creating, Opening and Saving CD Programs
The CD Program is the key to WaveLab's ability to burn real "red book compat
CDs. It is in this window that you assemble the files you want to appear on the
and make settings for them.

• To create a CD Program, pull down the File menu, select New, and from 
the sub-menu that appears, select CD Program.
You will get a blank window that you can fill with entries, as described on 
page 15.

• To open an already existing CD Program, select Open from the File menu, 
and CD Program from the sub-menu that appears. Alternatively, use the 
list of recently opened files at the bottom of the File menu.
When you open a CD Program, all the files it refers to are actually also 
opened. However, they do not appear in Windows. If some files that are part 
of the CD Program can't be found, a warning message appears.

• Once you have created your list, you can save it to disk like any other 
file, using the Save and Save As commands.
- 13 - 



     
About the CD Program window
• When a CD Program is active, a new menu appears called CD-Wizard. You 

can also open this menu from the top left corner of the CD program window.

The CD Wizard menu, here invoked from the CD Program window.

• You can have many CD Program windows open at the same time.
• The CD Program is merely a list of the file segments, it does not contain the 

actual files themselves. This means that changes you make to the files will be 
reflected in the list as well. In other words, it is very important to keep track of 
changes made to files that are used in several CD Programs, because these 
changes will appear in all these lists.
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Adding files to a CD Program

What audio file formats can be used?

You can add any type of file to a CD Program. However, when it is time to burn
CD, the files in the list must meet the following specifications:

• 44100 Hz (44.1kHz).
• Mono, dual-mono or stereo.
• 8, 16, 20 or 24 bit resolution.

The files will be converted to 16 bit stereo on the fly, while the CD gets 
burned.

● A Track can only appear once in each CD Program!
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Using Add Track

This item, on the CD Wizard menu is used to add Tracks directly from disk.

1. Select Add Track from the CD Wizard menu.

2. In the File dialog that appears, select as many files as you wish.

3. Click OK.
The files are now added to the list:

• If the file contains CD Start and Sub-Index markers, these are used to define 
the Track in the list.

• If there are several sets of markers, there will be several Track entries in the 
list, all "pointing" to this file.

• If the file does not contain any markers, a dialog box will ask you if you want 
to use the file start and end as boundaries for the Track. Click OK: you can al-
ways move the markers later to redefine the positions.

For more information about markers, see page 29.
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By dragging a Waveform Selection

If you already have a Wave window open, you can drag and drop selections fr
to the Track list.

1. Make a selection.
There are numerous ways of making selections. Let us just here mention the 
possibility to double click between two markers to select all audio between 
them.

2. Position the mouse pointer over the waveform, inside the selection area 
and drag and drop in the Track List.
The selection appears as a Track. If there are Sub-Index markers inside the se-
lection, they will be part of the Track. 
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You can drag a 
waveform 
selection into the 
CD Program to 
add it as a Track.
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By Dragging or Copying and Pasting between CD Programs

If you have several CD Programs open, you can drag and drop between them

1. Point at a Track item in a list.

2. Press the mouse button and drag and drop the Track item into another 
list.

You can also use Cut, Copy and Paste to achieve the same thing:

1. Select an item in one Track list.

2. Select Cut or Copy from the Edit menu.

3. Select another CD Program.

4. Select Paste from the Edit menu.
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Setting the order of the Tracks on the CD
Once you have all the files you need in the CD Program you might want to se
order they will appear on the CD.

Determining the current order

1. Pull down the CD Wizard menu and select "Sort by Track order".

2. Check the numbering on the side of the list, it is now consecutive and the 
list reflects the order of the Tracks on the CD.

The Track order
- 20 - 



           
Changing the order using Drag and Drop

1. Position the mouse pointer over the name of the Track you want to move 
to another position.

2. Drag and drop it somewhere else in the list.
The items get resorted to reflect the new order.

Changing the order using the keyboard

1. Select the Track you want to move up/down.

2. Hold down [Control] and press the Up/down cursor keys.
The file is moved up/down, accordingly.

Deleting files from CD Programs
There are two ways to remove a file from the Track list:

• Select it and select Delete from the Edit menu or press [Backspace].

• Drag-and-drop the track onto the trash icon.
The file disappears from the list, but is of course not deleted from the hard 
disk.
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Managing List columns
There are a couple of changes you can make to your Track columns:

• You can change the width of each column, by dragging the dividing lines 
between the headings left/right.

• You can hide/show each column by clicking with the right mouse button 
on a heading, and select from the menu that appears.

• You can click on the Title header to switch between three modes, that 
show various amounts of details about the files the Tracks belong to. This 
also switches the sort modes between "Sort by Track order" and "Sort by 
File".
- 22 - 



  
The three levels of file detail.

• You can also use the CD Wizard menu (that only appears when the CD 
Program is the active window), to switch between Sort by Track order" 
and "Sort by File".
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"Unfolding" a Track
Just like in the Explorer and other Windows 95 programs, you can unfold a Tr
to reveal additional settings. This can be done either by clicking the "+" and "-
symbols or by selecting the Track and using the [+] and [-] keys on the numeric
pad.

An “unfolded” Track.
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What information is available about a Track?

This shows you how far in on the CD this Track 
will start (in the format minutes:seconds:frames). 
The Start time is calculated from the length of the 
preceding Tracks.

This value is calculated 
from the position of the 
Track End marker, see 
below.

This is the pause that will precede the 
Track. The columns show the Start (a 
negative value since the pause starts 
before the Track) and the Length.

This is a representation of the marker that 
indicates the Start of the Track. The columns 
show the Start (always 00:00:00) and Length 
(calculated from the position of the previous 
Track End marker).

These indicate any Track Sub-Index markers that 
have been defined for the Track. The columns 
show the Start (the position of the marker) and 
Length (the time from this marker to the next Sub-
Index marker or the End of the Track, whichever 
occurs first).

These columns are all 
described on page 34.

This is a representation of the 
marker that indicates the end of the 
Track. The columns only show the 
Start (the position of the marker).
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Opening CD Tracks for wave editing
There are several ways to open a CD Program item, in a Wave window, for ed

• Double click on the Start time field.
This opens the Wave window and selects the entire track. If you double 
clicked on a Sub-Index marker or on a Track End marker, the Wave cursor is 
moved there. Otherwise the cursor is moved to the Track Start marker.

• Drag and drop a Track item, a Track Start marker or a Pause item onto the 
WaveLab background (outside all document windows).
This opens the corresponding wave window and selects the area inside the 
Track boundaries.

• Drag and drop a Sub-index or Track end marker onto the WaveLab back-
ground (outside all document windows).
This opens the wave window and moves the Wave cursor to the correspond-
ing position.

• Drag and drop a CD track onto an already open audio file window.
This inserts the Track into the file, as when you drag and drop between Wave 
windows. Please note that this must of course be a window for another file.
- 26 - 
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About the relation between the Track List and CD 
Markers

CD Markers appear in the audio files. They define the Start, End points and S
dex points for Tracks in the Track list.

To learn about the various Marker types, open the Edit Marker dialog (select "
Marker" from the time ruler menu) and use the context sensitive help for the it
in the dialog.

The illustration on the next page shows which items correspond to which in th
Track List vs the Wave window.
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The relation between markers in the CD Program and the Wave window.

Note the Track Boundary marker that 
indicates the end of one Track and the 
beginning of the next.
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Working with CD-Markers
You edit and add CD Markers using any of the following methods:

• By adjusting positions of existing CD markers.
This is done by dragging, as with any marker.

• By converting existing "Generic" or "Temporary" markers into CD type 
markers.
This is done by clicking on a marker with the right mouse button and selecting 
"Edit marker".
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The “Edit Marker” dialog.

• By adding markers on the fly, and then converting them into CD markers.

• By adding Markers using the New Marker function.
For details on the two options above, see page 60

• By dragging waveform selections into the CD Program.
See page 15.
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• By making a waveform selection and then selecting the speed menu op-
tion "Create track from selection".

• By using Add Tracks on files that have not previously been marked for CD 
Programs.

Remember that if you make a mistake, you can always Undo your actions.

About relations between markers in a file

To understand how CD Markers relate to the items in the CD Program, please
the following:

• A Track in the CD Program is defined by a Track Start or Track Boundary 
marker in the actual audio file! Delete the Track Start/Boundary marker, and 
the Track item vanishes from the list! Also, edit the Track start or end position, 
and the change is reflected in all CD programs that include this track.

• Just because you create the markers for it, this does not mean the Track will be 
added to a CD Program window. You have to do this "manually", using drag 
and drop to the desired CD program(s). As a matter of fact, you can have sev-
eral Tracks defined in a single audio file, but still decide to only use one or a 
few of them in a CD Program.

• Whenever you create a Track Start marker, WaveLab will automatically create 
a Track End marker at the start of the next Track or at the end of the file, which-
ever occurs first. It’s then up to you to adjust the position of that End marker if 
you like.
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• WaveLab does not allow Tracks that start but have no end. Neither will it al-
low overlapping or nested Tracks (Tracks inside Tracks). If you try to move 
Track markers to invalid places (beyond the end of the file, to a position inside 
another track, etc.), WaveLab will automatically reorganize the markers to a 
valid configuration.

• The Track Boundary Marker indicates the End of one Track and the Start of an-
other. In other words, it's a combined Start and End marker. If you drop a Start 
marker after another Start marker, it will automatically convert into a Bound-
ary marker since you can't have two Starts after each other without an End be-
tween them.

• If you use one file in multiple CD Programs, beware that any changes you 
make to the audio file will be reflected in all CD Programs!

• Sub-Index markers can be added between Starts and Ends as required. The 
only limitation is that there can only be 98 Sub-Index markers per Track. You 
can’t insert a sub-index outside a CD track. If you move a sub-index out of a 
CD track, it is deleted.

• Whenever you insert a sub-index, its position is quantized to a CD frame (1/
75th of a second, or 588 audio frames) relatively to the Track start. If you 
move the CD Track Start marker, then all Sub-Index markers will need to be 
re-quantized. You will be warned about this via an alert box. This is usually 
not a problem, since you will normally only start defining Sub-Indexes once 
your start and end points have been established.
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Adjusting Pauses
Each Track has a pause setting. This pause will be played before the beginni
the Track.

• To change the length of the pause, double click on the value (the dark red 
digits). As usual, you can right click on the numbers (after double click-
ing) to set the value using sliders.

Naming Tracks
• If you hold down [Alternate] and double click on a Track name, you can 

edit it (to be precise, what you are editing is the name of the CD Track 
markers in the audio file). Please note that this name is not stored on the 
CD (CD Tracks don't have names) This naming is only for your conven-
ience.
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Other settings
For background information about the following fields, see page 53.

• The ISRC field (see page 57) can be edited by double clicking.
• The comment field is also edited by double clicking. This text is not stored on 

the CD, it is only here for your convenience.
• The Key symbol indicates a track copy protection "flag" (on/off setting). Click 

here to activate /deactivate this flag. Please note that this setting is hardly ever 
used nowadays, and not all CD-R units can even handle it. Normally you will 
leave this off.

• The little Rainbow colored symbol indicates the Emphasis "flag". This setting is 
used to indicate if the Track was recorded with emphasis or not. Please note 
that this does not apply/remove emphasis from the audio, it is just an indica-
tor for how the file was created. Normally you will leave this off.

EmphasisCopy Protection ISRC Comment
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There is a shortcut for the last two settings: To set all Tracks to the same value
ble click on the column heading instead of the actual Track item.

Checking the Total Length of the CD
The total length of the CD is displayed at the bottom of the CD Program wind
- 35 - 



Playing files in the Track list
There are several ways to play back a file in a CD Program.

• Click with the right mouse button in the Track column for an item (any 
type of marker will work), and select from the menu items.
The items should hopefully be self explanatory. Please note that clicking on a 
Track End marker allows you to play a transition between two Tracks with a 
short pre-roll time.

• Double click on a Track name, or select it and press [Enter] or [F8].
This plays the entire list, from that point and on, including pauses. Hit [F7] or 
[0] on the numeric key pad to stop.

• Double click on a Length field.
This plays the section between this and the next marker.

• You can drag and drop a Track title onto the Play button on the Transport 
bar.
This is just as double clicking on the Track name.

• Please note that what you hear during playback is identical to the way the au-
dio will be played back from the actual CD, that is, all pauses and other ad-
justments are taken into account (this includes the Advanced Settings unless 
otherwise stated).
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• During playback, a progress bar appears at the bottom of the window. There 
will be no play cursor in the actual wave window.

• During playback, you can toggle between track-local time and CD-global 
time by clicking on the time counters in the bottom right corner of the CD 
program window.

• Changes to markers are not taken into account during playback (you need to 
stop playback and start again).

Playing back via the Master Section

To make the audio play back through the Master Section, activate the corresp
ing option in the CD-R tab in the Preferences dialog box, and open the Maste
dow. The default setting for this is OFF.
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Testing a CD Program before burning
There are two ways to check a CD before burning:

Check

The "Check" command on the CD Wizard menu scans through the CD Progra
and checks that the settings conform to the CD standard. This command doe
access the CD-R recorder in any way, it only checks the setting in the list aga
set of rules. These rules are described under the context sensitive help for the 
menu item. 

This check is automatically performed when you try to actually burn a CD.

"Test 1 track" and "Test All Tracks"

These two options in the Write CD dialog (also reached from the CD Wizard m
actually simulate writing of one or all Tracks to the CD. This takes all settings 
account, including the writing speed (1x, 2x, etc.).

• If the test fails, try writing at a lower speed.
• If the Test All Tracks test passes, you can be practically sure there will be no 

problems with writing the actual CD.
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Writing a CD
Once you have set up the CD Program, we suggest the following work order 
burning the CD. Please note that these steps are not mandatory, just a recom
tion.

● Please observe the precautions indicated in the Troubleshooting section in the 
on-line help, before writing your first CD!

1. Listen through the CD once more, from the CD Program window, to 
check that all starts, ends and transitions are OK.

2. Select Check from the CD Wizard menu, to check that all settings con-
form to the red book standard.
This is done automatically before burning, but you might want to do this any-
way at this point.

3. Insert a fresh CD-R disc into your drive.

4. Select Write CD from the CD Wizard menu.

5. Select the speed you expect to be able to burn at, from the small pop-up 
menu.
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6. Use the test options in the dialog to check that you will actually be able 
to write the CD at that speed.

7. Once the CD Program has passed the test, switch to "WRITE" and press 
OK in the dialog.
If you run into problems, check the Troubleshooting guide in the on-line help.
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Importing CD-tracks into a CD Program
WaveLab provides the ability to read audio Tracks right off regular CDs, both f
CD-ROM and CD-R drives. This makes a digital copy of the audio on the CD, r
into an audio file on your hard disk. Although WaveLab support a large numbe
drives, there are some restrictions you should be aware of:

• The drive has to be connected via SCSI. Regular ATAPI drives are not sup-
ported!

• There are a number of totally different, not very well standardized, pro-
tocols for retrieving audio from a CD-ROM/CD-R drive. WaveLab tries to 
support as many of these methods as possible, but there are not guaran-
tees it will work with any particular drive. Some brands that reportedly 
use the same method, still have slightly different implementations, which 
might cause problems.

• Plextor are, as far as we are aware, the only company that currently ad-
vertise that their drives really support reading of CD Tracks. This is of 
course an initiative we welcome. If you can get a drive from a manufac-
turer that make this kind of claim, you stand much better chances of get-
ting a solid solution, than otherwise.

• Please observe and respect any copyright notices on the CDs you are 
reading tracks from!
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1. Insert the CD into the CD-ROM/CD-R unit.

2. Pull down the File menu, select Open, and from the sub-menu that ap-
pears, select Import Audio CD Track.

3. Select the drive you want to read from, from the combo box at the top of 
the dialog.

4. Select a read speed from the menu just beside.
For information about which speed to use, check the on-line help for the 
menu.

5. f required, click Refresh so that the list gets updated.
The window now lists the Tracks on the CD, plus some information about 
each one. Please note that the Copy Protection and Pre-emphasis columns are 
only information fields, you can not change any settings.
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The “Import Audio CD” dialog.
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6. Click on the ". . ." button at the bottom of the dialog to select a folder for 
the file(s) and a template name for the file. If your file template for exam-
ple is "music", and more than one file will be created, the files will be 
named "music_1.wav", "music_2.wav", "music_3.wav", etc.

● IIf one or more files already exist with the same names, as specified here, they 
will replaced without warning!!!

7. If required, you can select one file and click Play Start.
This will play the beginning of the Track so that you can check it out.

8. Select as many the Tracks as you wish, from the list.
You can use [Control] and [Shift] to make multiple selections. There is also a 
Select All button.

9. Click the Save button.
The Tracks get retrieved one by one, and optionally, each is opened in its own 
window.
- 45 - 



Notes:

• The audio files are always saved in WAV (Wave) format.
• Note that importing audio CD tracks is technically more complicated than 

reading files from a CD-ROM or hard disk, because audio sectors can be hard 
to detect. Some CDs, which do not conform completely to the CD standard, 
may cause problems. Unfortunately, this is unavoidable.

• The read speed for audio Tracks might not be the highest speed the CD-R/CD-
ROM unit is capable of. Since audio CD reading is more prone to errors than 
for example CD-ROM reading, the read speed is adjusted downwards auto-
matically. For example, the Yamaha CDR-100, which reads CD-ROMs at 4x 
speed, will only read audio tracks at 2x speed.

• The ISRC code (see page 57) is not displayed in the dialog, since finding this 
code on the disc could take several minutes in some cases!

• If you import a CD track with Emphasis, and later want to use this on a CD of 
your own, remember to activate Emphasis for that Track in the CD Program.
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Creating a Disk Image
There might be situation where you want to "freeze" an entire CD project, with
actually burning a CD. This is done with the "Save As CD Image" command.

1. Set up the Track list so that it is exactly as you want it.

2. Select "Save As CD Image" from the CD Wizard menu.

3. Find a directory for the files (we recommend that you create a new direc-
tory, because the "image" is made up of three different files) and type in a 
name.

4. Click OK.

Now, the following is created in that folder:

• A CD Program file, with the specified name. This is the file you will want to 
open the next time you want to access this "CD image".

• A single wave file, containing all the Tracks, with markers inserted at all the 
correct positions.

• A marker file with the same name (it is this file that actually contains the 
markers).

• A peak file for the wave file.
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Exporting audio files from a Track list
There are situations where you might want to save the items in a CD Program
dio files on your hard disk. For example:

• For archiving.
• For burning a mixed mode CD in another program.
• When you use the CD Program as a general play list for preparations of files 

for other purposes.

As separate files

To save the files in a CD Program as separate files, proceed as follows:

1. Set up the Track list so that it is exactly as you want it.

2. Select "Save each track as a separate audio file" from the CD Wizard 
menu.
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The “Save each track as a separate audio file” dialog.

3. Find a destination folder for the files.

4. Fill out the other options in the dialog.
See the context sensitive help in the dialog for details.

5. Click OK.

Now, each of the Tracks in the list are saved as one file, in the specified folde
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As one file

To turn the entire CD Program into one long file, proceed as follows:

1. Set up the Track list so that it is exactly as you want it.

2. Select "Join all tracks into one virtual file" from the CD Wizard menu.

3. Fill out the other options in the dialog.
See the context sensitive help in the dialog for details.

4. Click OK.
The new file appears in a wave window.

5. Save the file, like any other wave file.
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Exporting texts from a Track list
You might want to export the text information (Track names, comments etc.) in
CD Program, for use in a word processing or layout program. Proceed as foll

1. Select "Copy to clipboard as text" from the CD Wizard menu.
A Notepad window with the text appears. It is also copied into the Windows 
clipboard.

2. Save the Notepad file or switch over to another program and paste in the 
text there.
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Introduction
This text aims to provide you with some background information on the CD fo
mat, to help you better understand how to create your own. This is a big subje
and we will only be able to touch upon it here. For more information, try a tex
book on the subject, or search the Internet for more information.

The basic CD-formats

There are a number of different formats for the contents of a CD disc. You are 
ably familiar with audio CDs, CD-ROMS, and CD-I. These are all slightly diffe
ent, although they use the same media - CD discs. The audio CD specification is 
called "red book". It is this standard that WaveLab conforms to.

Red Book CD is not a real file format

Those of you who are computer literate, might now about file formats. Please
that red book CD is not a real file format. All the audio on the CD is stored in 
big chunk, one file if you will. This is different from for example hard disks, whe
each file is stored separately. Understanding the fact the all the audio is in fac
long stream of digital data is something that will probably help you understand
limitations of the format better.
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The different types of "events" on an audio CD

There are basically three types of events that can be used to specify various se
of audio on the CD. These are:

Track Start There can be up to 99 Tracks on one CD. Each is identified by 
its start point only.

Track Sub-Indexes On advanced CD players, you might have noted that a Track 
can be divided into Sub-Indexes (sometimes called only In-
dexes). These are used to identify "important" positions within 
a Track. There can be 98 Sub-Indexes in each Track. However, 
since it is difficult and time-consuming to search for and lo-
cate to a Sub-Indexes, many CD players simply ignore this in-
formation.

Pause A pause appears before each Track. Pauses can be of variable 
lengths. Some CD players indicate the pauses between Tracks 
on their displays.
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About Frames, positions, small frames and bits

The data on an audio CD is divided into frames. A frame consists of 588 stereo 
samples. 75 frames make up one second of audio. Why? Well 75*588= 44100
since the sampling frequency of the CD format is 44100kHz (samples per sec
this equals one second of audio. When you specify positions on the CD, in W
Lab, you do it in the format mm:ss:ff, where mm is minutes, ss is seconds and
frames. The frame values go from 0 to 74, since there are 75 frames to a sec

Technically, there is no way to specify something smaller than a frame on a C
One effect of this is that if the length of a Track on the CD does not equal a pe
number of frames, some blank audio must be added at the end. Another effec
this is that when you play the CD, you can never locate (position) to anything c
than a frame. If you need some data in the middle of a frame, you still have to
the whole frame. Again, this is unlike a hard disk, where you can retrieve any 
on the disk, without reading the surrounding data.

But frames aren’t the smallest block of data on a CD. There is also something
called "small frames". A small frame is a container of 588 bits. 98 small frame
gether make up one regular frame. In each small frame there is actually only 
for six stereo samples, which means that a lot of space is left for other data tha
actual audio. There is information for encoding, laser synchronization, error co
tion and the PQ data (named so "simply" because they are stored in the "P" an
bits). This PQ data is of major importance to anyone who wants to create their
CD, so please let us explain it in further detail.
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PQ codes and WaveLab's solution to handling them

The PQ codes convey information about Track Start, Sub-Indexes and Pause
described above. They also contain the timing information (minutes, seconds
frames). To fit all this information in, a block of PQ information is spread out o
98 small frames.

Specifying PQ codes is not complex. However, when creating a CD there are
number of rules you must take into account. For example, there should be so
lent frames before each track, Sub-Indexes should be slightly early, there shou
pauses at the beginning and end of the entire CD, etc.

In WaveLab, all these hidden rules are collected in a dialog box called "Advan
Settings". If you don't change these, you will get default values that ensure you
will work properly. On the other hand, when the situation so requires, you can
just them. We recommend you leave these settings as they are, unless you a
pletely sure of what you are doing.
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ISRC codes

In addition to the basic PQ codes, there is something called "International Stan
Recording Code", identification that is only used on CDs intended for comme
distribution. WaveLab allows you to specify an ISRC code for each audio trackbut 
only if your CD-R burner supports it.

The ISRC code is built up as follows:

• Country Code (2 ASCII characters).
• Owner Code (3 ASCII characters).
• Recording Year (2 digits).
• Serial Number (5 digits). 

UPC/EAN codes

UPC stands for "Universal Product Code". Some CD-R units allows you to spec
this code, which is a thirteen-digit catalog number for the disc. Also known as
EAN.
- 57 - 



 rea-

 must 
in 
f writ-
r-
ill be 
hese 

e-

 be-
isk 
dio 
he en-
Disc-At-Once - Writing CD-R's for duplication into "real" CDs

WaveLab only writes audio CDs in Disc-at-Once mode. There are three good
sons for this:

If you want to create a CD-R to use as a master for a real CD production, you
write the CD-R in Disc-At-Once mode. In this mode, the entire disc is written 
one pass, without ever turning off the recording laser. There are other ways o
ing a CD, namely Track-At-Once and MultiSession. If you use these writing fo
mats, the "link blocks" created to link the various recording passes together w
recognized as "uncorrectable errors" when you try to master from the CD-R. T
links can also result in clicks when playing back the CD.

Disc-At-Once mode provides more flexibility when specifying pause lengths b
tween tracks.

Disc-At-Once is the only mode that supports Sub-Indexes.

Writing on the fly vs CD images

WaveLab always writes a CD on the fly, that is, it does not create a CD image
fore burning. This method makes writing CDs faster and requires much less d
space. However, if for some reason you need to, WaveLab lets you join all au
tracks in a CD Program into one large file that can be used as an "image" of t
tire CD.
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Introduction
The handling of markers has been improved in version 1.6. Below follows a d
scription of the new possibilities:

New Marker types
There are now several types of markers:

• Generic
• Temporary
• CD Track markers: Start, End, Boundary and Sub-Index.
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New ways to enter markers
Here are the new ways to insert markers:

• Use the new "New Marker item" on the time ruler pop-up menu, to add a 
marker of any type at the Song Position. A dialog appears where you can 
specify the type of marker and other parameters.

The “New Marker” dialog.
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• Press [Control]+[Insert] as a shortcut for the "New Marker" operation de-
scribed above.

• Press [Insert] as a shortcut to drop a temporary or generic marker at the 
current cursor position.

• Use the "Drop temporary Marker" item in the Units tab in the Preferences 
dialog to set things up so that dropped markers (using the [Insert] key or 
the Drop marker menu item) are of the Temporary type rather than Ge-
neric.

• By clicking on the Marker button in the Record dialog, while Recording.

Click here to add a 
Marker during 
recording.
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Improved Marker editing and visibility control
There is now a completely new window dedicated to marker properties. There
two ways to open this:

• Right click on the marker in the time ruler and choose the "Edit Marker" 
from the menu that appears. 

• Hold down [Alternate] and double click on the marker.
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This window allows you to transform any marker into any other type. It also all
you to rename the marker. See the context sensitive help in the dialog for mo
tails.

Marker sort order
The marker list window (that appears when you double click on the time ruler
now by default sorted by marker position and not by marker name as in version
As before, you can select any sort method by clicking on the column heading

Drag-copying of markers
You can now duplicate markers by pressing [Shift] while dragging a marker in
ruler.
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Locating to and Playing from Markers
• Clicking on a marker in the marker window moves the wave cursor to the 

marker position.
• Double clicking in the same way activates playback from that point.
• You can select markers with the Up/Down cursor keys and activate playback 

by pressing [Enter].
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